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STATEMENT OF WARRANTY ON MONARCH MACHINES

Limited Warranty

THIS LIMITED WARRANTY IS IN LIEU OF AND EXCLUDES ALL OTHER
WARRANTIES OR REPRESENTATIONS EXPRESSED OR IMPLIED,
INCLUDING MERCHANTABILITY OR FITNESS FOR BUYER’S PURPOSES.
THERE IS NO WARRANTY WHICH EXTENDS BEYOND THE LIMITED
WARRANTY.

The Monarch product covered by this limited warranty is warranted to be free
from defects in materials and workmanship for a period of one (1) year from the
date of shipment to the original purchaser.  The limited warranty on the
printhead is one (1) million inches or 100,000 inches for High Energy Ribbon.

This limited warranty does not cover damage by accident, abuse or violence, or
use by the original purchaser of other than the standard supplies furnished by
or meeting the specification of Monarch, or the Monarch product is operated or
maintained contrary to the instructions provided by Monarch.  This warranty is
void if the machine is altered or repaired by other than Monarch
representatives.

This warranty does not include the furnishing of ribbons, ink rollers, tags,
labels, or other supplies.

The Monarch product requiring warranty service may be shipped to the nearest
authorized Monarch service facility with the transportation charges PREPAID.
Monarch is NOT responsible for damage that occurs during shipment if the
product is not shipped in the original Monarch packaging.  The Monarch
product will be repaired free of charge during the warranty period.

This warranty is valid only in the United States.









G E T T I N G  S TA R T E D 1
The Monarch® 9820 printer and Monarch® 9830 printer let you
print text, graphics, and bar codes on thermal transfer (ribbon) and
thermal direct labels.  The 9820 printer prints labels continuously
(in one strip) or on-demand (one label at a time).  The 9830 printer
has a peel bar that allows labels to be peeled as they are printed
in the on-demand mode.

You can print on die cut, black mark, or non-indexed (continuous)
supplies.  Non-indexed supply does not have perforations or black
marks and must be used in continuous mode.  See Appendix B,
"Setting DIP Switches," to select your supply type.

This chapter includes information about

u unpacking the printer.
u connecting the power cord.
u connecting the communications cable.
u using the printer’s control panel.
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A u d i e n c e

The Operator’s Handbook is for the person who prints and applies
labels.

O r d e r i n g  P r o g r a m m e r ’ s  M a n u a l s

An online version of the Packet Reference Manual describes how
to create a format and batch packets for printing labels, how to
configure the printer online, how to diagnose printer error
messages, and how to perform other advanced techniques.  It is
included with the MONARCH® quick-set software where you can
print this manual or order a hard-copy version of the Packet
Reference Manual (part number TC9800PM).

To install the software, see Chapter 2, "Using the Software."

U n p a c k i n g  t h e  P r i n t e r

After you unpack the printer, you should have:

u 9820 or 9830 printer
u Power cord
u Ribbon take-up core (may already be on take-up reel)
u Operator’s Handbook
u MONARCH quick-set software.

Keep the box and packaging material in case
the printer ever needs repair.
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C o n n e c t i n g  t h e  P o w e r  C a b l e

To connect the power cable:

1. Plug the power cable into the socket.  Plug the other end of
the cable into a grounded electrical outlet.

2. Turn on the printer.  Press ( I ) to turn on and ( O ) to turn off
the printer.

For information about replacing the fuse, see Chapter 6,
"Care and Maintenance."

E s t a b l i s h i n g  C o m m u n i c a t i o n s

Before the printer can accept print jobs from the host, you must:

u Connect the communication cable to the printer and to the
host.

u Set the communication values on the printer to match those at
the host.  (Only required if you are using the serial port.)

Power Cable
goes here
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C o n n e c t i n g  t h e  C o m m u n i c a t i o n  C a b l e

Make sure the printer is off before connecting
the cable to the communication port.

Ask your System Administrator which method you will use to
communicate with the host:

u Serial Communication
9 to 25 pin cable (Part #118364)
25 to 25 pin cable (Part #118366)

u Parallel Communication
IEEE-1284 or Centronics® mode cable (Part #118363)  See
Appendix B, "Setting DIP Switches" for more information.
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Connect the communication cable into the appropriate port.
Secure the cable with the connecting screws (serial) or spring
clips (parallel).

D e f a u l t  S e r i a l  P o r t  C o m m u n i c a t i o n  V a l u e s

If you are communicating with the host through the serial port,
make sure the printer’s communication values match those at the
host. The factory default values are:

u Baud: 9600
u Word Length: 8 bit data frame
u Stop Bits: 1 stop bit
u Parity: none
u Flow Control: DTR

To change the printer’s communication values, ask your System
Administrator or see Appendix B, "Setting DIP Switches."

Parallel Port

Serial Port
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U s i n g  t h e  C o n t r o l  P a n e l

The control panel helps you check printer status, displays error
codes, and allows you to perform some basic printer functions.

P r i n t e r  S t a t u s  L i g h t s

Power: The printer shows a steady green light when
it is on.

Supplies: The printer shows a blinking amber light when
it is out of labels or ribbon, or when you have
a supply jam.

Paused: The printer shows a steady amber light when
paused.

The printer shows a blinking amber light when
there is a data, communication, or data
formatting error.  See the status code box for
the error code.

The printer also shows a blinking amber light
when it’s ready to print a label in the
on-demand mode.  See "On-Demand Mode
Printing" for more information.
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B u t t o n  F u n c t i o n s

Feed: u Prints a label in the on-demand mode.
u Feeds a blank label if there is no print job.
u Prints a label with error information that is

useful to your System Administrator.

Pause: Pauses the current print job or resumes a
paused print job.

Feed and Pause: Prints a test label when you press the buttons
at the same time.

Feed and Clear: Allows you to adjust print positions from
paused mode.  See "Adjusting Print
Positions" in Chapter 5 for more information.

Clear: u Clears an error.
u Cancels the current print job.
u Cancels all queued print jobs if pressed

for two seconds.  Also clears the
communication queue and cancels any
packet being received.

To cancel a single or all queued print jobs, the printer must be in
paused mode before Clear is pressed.

S t a t u s  C o d e  B o x

The status code box displays a three-digit error code to identify
any problem the printer may have.  For a description of the
problem, look up the error code in Chapter 7, "Troubleshooting."

If there is no error, the display will be blank.
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U S I N G  T H E  S O F T W A R E 2
This chapter describes how to

u install the MONARCH quick-set software
u use the software.

Four of the diskettes you received with your printer contain
MONARCH quick-set software:

u Printer Configuration Utility (configures printers)
u Label Designer Utility (assists in designing formats)
u File Download Utility (downloads MPCL packets to printers)
u Font Utility (converts and downloads custom fonts)
u Windows drivers (allows you to print from a Windows

application using your Monarch® printer)

Two more diskettes contain Adobe Acrobat Reader.  The last
diskette contains an online version of the Packet Reference
Manual.

Label Designer allows you to design fixed or
variable fields on formats.  However, you cannot

enter variable field data using the MONARCH
quick-set software.  You need a entry package, such

as MONARCH® PLATFORM.

To produce custom labels, you must create several Monarch
Printer Control Language (MPCL) packets.  These packets tell the
printer where data should be positioned on the label, what data
should print, and much more.
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I n s t a l l i n g  t h e  S o f t w a r e

MONARCH quick-set software works with Microsoft® Windows®
3.1 or greater.  Printer Configuration and File Download are also
available as DOS programs.

1. Start Windows.

2. Insert the Printer Configuration and File Download Disk 1 into
your floppy drive.

3. From the Program Manager File menu, choose Run.

4. Type A:\SETUP.EXE and click  f .

If your diskette is in a drive other than A:, change the
command line accordingly.

5. Respond to additional prompts as necessary.  When Setup is
complete, a box displays Setup Succeeded! Click  f .

6. Repeat the above instructions for the Label Designer and
Font Utility diskettes.

D O S  I n s t a l l a t i o n
1. Insert the Printer Configuration and File Download Disk 1 into

your floppy drive.

2. At the DOS prompt, type A:\INSTALL.EXE and press  W .
If your diskette is in a drive other than A:, change the
command line accordingly.

3. Respond to additional prompts as necessary.  When Setup is
complete, a box displays Setup Succeeded! Press  W .
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I n s t a l l i n g  t h e  W i n d o w s  D r i v e r

A Windows Driver is available for these printers.  The Windows
Driver works with Windows 3.1, Windows 95, and Windows for
Workgroups 3.11.

1. From the Windows Control Panel, select Printers.
If installing for Windows 95, choose the Printers Folder
instead of the Control Panel.

2. Insert the Windows Driver diskette into your floppy drive.

3. Click  a  and then click  u .

4. Type A:\ and click  f .

If your diskette is in a drive other than A:, change the
command line accordingly.  You will see

5. Select the printer.  Click  f .

Make sure the printer is connected to the
correct port.
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6. Click Setup if you need to change the printer’s setup.  You
will see the Monarch Printer Setup box.

You can change any of the following setup options:  Ribbon, Feed
mode, Supply Type, Supply/Print/Margin positions, Print Speed,
and Print Contrast.  You can also enable Overfeed or Batch
Separators.

7. Click  f  when you are finished with the setup options.
The printer driver is now ready to use.

Online help is available by clicking Help from the Monarch Printer
Setup box.
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I n s t a l l i n g  A d o b e  A c r o b a t  R e a d e r

If you want to refer to the Packet Reference Manual, you must
install Adobe Acrobat Reader and the online version of the
manual.

1. Start Windows.

2. Insert the Adobe Acrobat Reader - Disk 1 diskette into your
floppy drive.

3. From the Program Manager File menu, choose Run.

4. Type A:\DISK1\SETUP.EXE and click  f .

If your diskette is in a drive other than A:, change the
command line accordingly.

5. Respond to additional prompts as necessary.  When Setup
prompts you to enter the next diskette, insert the Adobe
Acrobat Reader - Disk 2 diskette into your floppy drive. Click 
f .

6. When Setup is complete, a box displays Installation is
complete. Click  f .

I n s t a l l i n g  t h e  O n l i n e  D o c u m e n t a t i o n  F i l e

After you install Acrobat Reader, you must install the
documentation file to be read.

1. Start Windows.

2. Insert the Online Documentation diskette into your floppy
drive.

3. From the Program Manager File menu, choose Run.

4. Type A:\SETUP.EXE and click  f .

If your diskette is in a drive other than A:, change the
command line accordingly.
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5. Click  f  to accept C:\QUICKSET.  If you changed the
default directory when you installed the quick-set software,
change this directory accordingly.  Setup begins copying the
file. 

6. When Setup is complete, a box displays Setup Succeeded!
Click  f .

To  u s e  t h e  o n l i n e  m a n u a l :

1. Start Windows.

2. Double-click the Packet Reference Manual Icon from the
MONARCH quick-set program group.

Acrobat Reader begins and you see the cover of the Packet
Reference Manual.  For help on using Acrobat Reader, press F1
or select Help from the menu bar.

U s i n g  T h e  S o f t w a r e

The following steps walk you through configuring your printer,
creating a format, converting a font, creating the data, and then
downloading the packets.

Packet refers to a file that contains information for the printer,
formatted in a way that the printer can understand.  Packets must
begin with { and end with }.  Everything in between these brackets
must follow proper MPCLII structure.  Specific MPCLII
requirements are addressed in the online version of the Packet
Reference Manual that is provided with your printer.  The Monarch
quick-set software also helps you develop your packets by
automating some of the packet creation process.

After you create a packet, you must download the packet to the
printer.  Your printer comes with MONARCH quick-set File
Download, which mimics a DOS COPY command to the
appropriate printer port.  As you download a packet, one or more
of the File Download status panels becomes active on the
computer screen.
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Monarch quick-set Printer Configuration has a
built-in download function and does not

require use of File Download.

Before you download any format or batch packets, configure your
printer.

C o n f i g u r i n g  t h e  P r i n t e r

The printer must be connected and configured before any
communication can take place.  MONARCH quick-set Printer
Configuration is provided with your printer to help you develop a
configuration packet.  This software sets your PC port to match
the printer’s communication values, and then creates and
downloads a configuration packet based on your screen
selections, such as supply type or currency symbol.  The values
are saved to a file with an extension of .PCF.

If you don’t use Printer Configuration to configure the printer, set
the port values using a MODE command (serial port only), create
a configuration packet using Notepad, and then use a COPY
command to download the configuration packet.

You can also configure the printer using the Windows Driver.  See
"Installing the Windows Driver" for more information.

1. Connect the printer to your PC.  If you don’t have a cable,
contact your service representative to order one.

2. Double-click the Printer Configuration icon from the
MONARCH quick-set program group.

3. In the Communications Port box, select the port that is
connected to the printer.

4. From the Printer menu, select Query Printer Values to load
the printer’s current configuration on the screen. 
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5. Make any necessary changes to the configuration screen.  If
you aren’t sure what settings to use, try the default settings
that were loaded from the query.

6. From the Printer menu, select Send To Printer to download
the new configuration.  

7. From the File menu, select Save As...

8. Type SAMPLE.PCF and click  f  to save this configuration.

9. From the File menu, select Exit to Printer Configuration.

U s i n g  t h e  D O S  Ve r s i o n

A DOS version of Printer Configuration and File Download are
available.

1. From the DOS prompt, change directories to
C:\quickset\local or to the directory where you installed
quick-set.

2. Type config and press  W .

The DOS version of Printer Configuration begins.  Use  U  or
the "hot keys" to move around the screen.

D e s i g n i n g  t h e  F o r m a t

You must design a format to tell the printer how the label should
look.  A format packet is one of the more difficult packets to
create, because it determines the appearance of a label.  For this
reason, MONARCH quick-set Label Designer is provided with
your printer.  This software calculates field coordinates as you
design a simulated label on your computer screen, and saves the
information to a Label Designer file.  You must then convert the
information by saving it as an MPCL format packet (.FAB
extension).  As with the other packets you create, the format
packet can be downloaded using File Download.  For help in
using Label Designer, refer to the online help available on the
Label Designer menu bar.
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1. Double-click the Label Designer icon from the MONARCH
quick-set program group.

2. From the File menu, select New...

3. Type SAMPLE.FMT and click  f .

4. Double click on your printer number (in the Available box) and
click  f .

5. Click in the Length box and enter 6.0.

6. Click in the Width box and enter 4.0.

7. Click  f .

8. From the Edit menu, select Add and then Text...

9. Select Fixed in the Field Type box and then click  g .

10. Type ITEM NO: and click  f .

11. Type 2 in the Magnification Height and Width boxes and click 
f .

12. Click and drag the field somewhere near the top of the tag.
Be careful not to position it off the edge of the label.

13. From the Edit menu, select Add and then Text...

14. Click  g .
Data will be entered later using a batch packet.

15. Type 5 in the Maximum box and click  f .

16. Type 2 in the Magnification Height and Width boxes and click 
f .

17. Click and drag the field next to the other field you created.

18. From the Edit menu, select Add and then Bar Code...

19. Select Code128Num in the Bar Code Type box and click 
f .
Data will be entered later using a batch packet.

20. Click and drag the field somewhere near the bottom of the
label.
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21. If you want to save the batch information with your format,
select Save MPCL Batch from the Options menu.  (If you do
not want the batch information saved with the format, make
sure the Save MPCL Batch is not checked.)

22. From the File menu, select Save As MPCL...

23. You will be prompted to save the base file (SAMPLE.FMT) for
future editing.  Click  f .

24. Type SAMPLE.FAB and click  f .  You can use File
Download to send the .FAB file to the printer.

25. From the File menu, select Exit...

C o n v e r t i n g  a  F o n t

Your printer comes with several standard fonts.  You can convert
and download custom fonts to your printer using the MONARCH
quick-set Font Utility.  The font packet also includes a font
identifier that must later be referenced by the format.  If you use
Label Designer to create the format, any fonts that you download
appear in the Font Style list box.

Refer to the online version of the Packet Reference Manual for
information on referencing a font identifier.

1. Double-click the Font Utility icon from the MONARCH
quick-set program group.

2. From the File menu, select Convert Font File....  You will see
the Character Selection box.

3. Click Font Type and select from HP Laserjet, HPCL4, or
TrueType.  Click  f  when you are finished.

4. Click Font... and select the font, style, and point size you
want to convert for TrueType fonts.  For HP fonts, select the
.sfp file and click  f  when you are finished.
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5. Select from a Predefined Character Set or use a custom
character set by highlighting characters with the mouse.
Select characters by clicking the left mouse button.  Deselect
characters by clicking the right mouse button.  Selecting only
the characters you need reduces the size of the font packet.

Make a note of the Font ID, because it is the
number you need to use in your format.

6. Click Convert...

7. Enter a name for the font file with a .pcl extension.  Click 
f .  The font file is converted.

8. Click Download...  Choose the font file to download and click 
f .  Make sure the printer is connected and ready to
receive data.  The font file is downloaded and ready to use.

P r o v i d i n g  D a t a

The printer must receive a batch packet to initiate printing of a
label.  If your format has any variable data (a field defined as
Field Type = Entry in Label Designer), you must supply the data
within the batch packet.

With Label Designer, you can either append a dummy batch
packet to the end of the .FAB file or only save the format file.  You
can edit the dummy batch packet to contain actual data to print.
If you only saved the format file, you can create your own batch
packet.

1. Double-click the Notepad icon from the Accessories program
group.

2. From the File menu, select Open... and select
C:\QUICKSET\FAB\SAMPLE.FAB.  A dummy batch packet
exists at the end of this file.
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3. Modify the batch packet to look like the sample below. 

{B,1,N,1 p 
 1,"12345" p 
 2,"1234567890" p }

4. From the File menu, select Save and then Exit to close
Notepad.

If you print the same data on the label every time, you can define
the fields of your format to contain fixed data.  This is a very quick
way to print and the batch packet is simple.  The batch packet
identifies which format to use, but contains no actual data. Here
is a batch packet that prints one label made up entirely of fixed
data:

{B,1,N,1 p }

If your data varies with the application or product, you can define
the fields of your format to expect entered data.  In this case, a
batch must identify which format to use and must contain the data
to print.  Here is a batch packet that prints one label that has two
entry fields:

{B,1,N,1 p 
 1,"BARKER & BATES" p 
 2,"120 EMERSON LANE" p }

Refer to the online version of the Packet Reference Manual  that
is provided with your printer for information on creating a batch
packet (usually contained in the .FAB).  You can use File
Download to download the batch packet to your printer.
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D o w n l o a d i n g  P a c k e t s

Packets don’t take effect until they are downloaded to the printer.
The batch packet initiates printing of the label when it is
downloaded.  That’s why it’s important to attach the batch packet
to the END of the .FAB file, or download it last if it’s a separate
packet.

1. Double-click the File Download icon from the MONARCH
quick-set program group.

2. Select a communications port from the Communications Port
box.  If you aren’t sure which port to use, try the default
setting that first appears.

3. From the File menu, select Send...

4. Type C:\QUICKSET\FAB\SAMPLE.FAB in the Filename box
and click  f .  A label similar to this should print.

The batch packet should always be the last
packet the printer receives.  If you create a

batch packet that is separate from the format
packet, be sure to send the batch packet

AFTER the format packet.
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5. From the File menu, select Exit to close File Download.

U s i n g  t h e  D O S  Ve r s i o n

1. From the DOS prompt, change directories to
C:\quickset\local or to the directory where you installed
quick-set.

2. Type dload and press  W .

The DOS version of Printer Configuration begins.  Use  U  to
move around the screen.

C a n  I  P r i n t  L o g o s  a n d  O t h e r  P i c t u r e s ?

You can include logos and other graphics on your label.  If your
graphic is an 8-bit monochrome bitmap (.BMP extension), you can
use Label Designer to place the graphic in your format. You can
also download graphics packet to the printer (contact Monarch for
details on acquiring graphics packets).  The graphic ID must then
be referenced within the format packet.  Refer to the online
version of the Packet Reference Manual for information on
referencing a graphic identifier.

I s  A d d i t i o n a l  S o f t w a r e  A v a i l a b l e ?

Additional software can also be purchased to further simplify the
development process.  For example, MONARCH® PLATFORM
Software works with multiple Monarch printers and is made up of
the following software:

Format Editor Creates a format file that Entry Services uses.

Entry Services Prompts for variable data.

Spooler Configures the printer port, converts format
and data into packets, and downloads
packets to the printer.
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L O A D I N G  S U P P L I E S 3
This chapter describes how to load:

u a roll of supply
u fan-fold supply
u a roll of supply for peel mode.

There are three types of supplies:

Thermal Direct specially treated thermal supplies that do not
use a ribbon for printing.

Thermal Transfer standard supplies that require a ribbon for
printing.

High Energy scratch, chemical, and temperature resistant
supplies that require a ribbon able to
withstand high temperatures.  See "Using a
High Energy Ribbon" in Chapter 4 for more
information.

If you are using thermal direct supplies, do not load a ribbon.

High energy supplies are only available
for the 9830 printer.

If you switch from black mark to die cut supplies, make sure the
DIP switches are set correctly.  The System Administrator can also
send the supply setup packet or use the Printer Configuration
software (provided with the printer) to change the supply type.
Refer to the online version of the Packet Reference Manual for
more information about sending the supply setup packet.
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L o a d i n g  L a b e l s

Make sure the printer is configured for the correct supply type.  To
load fan-fold labels, see "Loading Fan-Fold Labels."

To load a roll of labels:

1. Open the cover.

2. Unlock the printhead by turning the retaining latch.
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3. Lift printhead assembly using the printhead tab until the
assembly locks into place.

4. Place the roll of supply on the supply holder.  Make sure the
supply unrolls from the top as shown.

Do not pick up the printer
by the supply holder.

5. Adjust the supply holder guides so the sides barely touch the
roll.  Make sure the supply roll turns freely.

Printhead Tab

Deflector Tab

Supply Holder
Guides
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6. Push down on the supply lever to unlock the supply guides.

7. Lay the label strip across the supply guide so that a few
inches extend past the front of the printer.  Tuck the supply
under the nibs.  

Make sure a few inches of supply are past the
front end of the printer.

8. Adjust the supply guides so they touch the supply.  Push up
on the supply lever to lock the supply guides into place.

9. Hold the printhead assembly by the printhead tab while
pressing down on the printhead release.  

Nibs

Supply Lever
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10. Close the printhead by pressing down on the thumb well until
you hear it click into place.  

11. Close the cover.

12. Press Feed to position the supply under the printhead.

You may need to adjust the wide/narrow
knobs depending on the width of your supply.
See Chapter 6, "Care and Maintenance," for

more information.

Thumb Well
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L o a d i n g  F a n - F o l d  L a b e l s

Make sure the printer is configured for the correct supply type.

To load fan-fold labels:

1. Open the cover.

2. Unlock the printhead by turning the retaining latch.
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3. Lift printhead assembly using the printhead tab until the
assembly locks into place.

4. Place the supply stack behind the printer, label side facing up.
(The supply may be kept in the box.)

5. Push down on the supply lever to unlock the supply guides.

6. Lay the label strip over the supply holder and across the
supply guide so that a few inches extend past the front of the
printer.  Tuck the supply under the nibs on the supply guide.

Printhead Tab

Deflector Tab
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7. Adjust the supply guides so they touch the supply.  Push up
on the supply lever to lock the supply guides into place.

Make sure a few inches of supply are past the
front end of the printer.

8. Hold the printhead assembly by the printhead tab while
pressing down on the printhead release.  

Nibs

Supply Lever
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9. Close the printhead by pressing down on the thumb well until
you hear it click into place.  

10. Close the cover.

11. Press Feed to position the supply under the printhead.

You may need to adjust the wide/narrow
knobs depending on the width of your supply.
See Chapter 6, "Care and Maintenance," for

more information.

Thumb Well
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L o a d i n g  L a b e l s  f o r  P e e l  M o d e  ( 9 8 3 0  o n l y )

In peel mode, the printer separates the backing paper from the
label.  The next label is not printed until the completed one is
removed from the printer.  Make sure the printer is configured for
on-demand mode and the correct supply type.  The minimum feed
length for peel mode is 1.5 inches.  You must use non-perforated
supplies for peel mode.

Hold the leading edge of peeled labels when
printing on stock longer than six inches. 

1. Open the cover.
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2. Unlock the printhead by turning the retaining latch.

3. Lift printhead assembly using the printhead tab until the
assembly locks into place.

Printhead Tab

Deflector Tab
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4. Place the roll of supply on the supply holder.  Make sure the
supply unrolls from the top as shown.

Do not pick up the printer by the supply holder.

5. Adjust the supply holder guides so the sides touch the roll.
Make sure the supply roll turns freely.

6. Push down on the supply lever to unlock the supply guides.

7. Lay the label strip across the supply guide so that at least 10
inches extend past the front of the printer.  Tuck the supply
under the nibs.

Nibs

Supply Lever

Supply Holder
Guides
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8. Adjust the supply guides so they touch the supply.  Push up
on the supply lever to lock the supply guides into place.

9. Hold the printhead assembly by the printhead tab while
pressing down on the printhead release.

10. Close the printhead by pressing down on the thumb well until
you hear it click into place.

Thumb Well
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11. Remove the labels from the first 10 inches of the backing
paper.

12. Press down on the exit cover tabs to open the exit cover on
the front of the printer.

13. Feed the backing paper over the peel bar.

Peel bar

Lower Opening

Exit Cover
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14. Feed the backing paper through the lower opening of the exit
cover.  Pull down on the backing paper to remove any slack.
Close the exit cover. 

When removing the backing paper, pull up
across the saw-toothed tear edge.  Make
sure the backing paper tears at the edge.

15. Close the cover.

16. Press Feed to position the supply under the printhead.

You may need to adjust the wide/narrow
knobs depending on the width of your supply.
See Chapter 6, "Care and Maintenance," for

more information.

Backing Paper

Tear Edge
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U s i n g  t h e  O p t i o n a l  Te a r  B a r

Tear labels against the tear bar.   Note the following change to
loading labels if you’ve purchased the optional tear bar:

Slide the supply between the tear bar and peel bar.

Do not tear both label and backing paper at
the same time.

u Tear labels against the tear bar.
u Tear backing paper against the tear edge.

Backing Paper

Tear Edge

Tear Bar

Peel Bar
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L O A D I N G  R I B B O N 4
This chapter describes how to load a ribbon roll.

There are different ribbon requirements for the three types of
supplies:

Thermal Direct
Supplies

do not use a ribbon for printing.

Thermal Transfer
Supplies

require a ribbon for printing.

High Energy
Supplies

require a ribbon able to withstand high
temperatures.

High energy supplies are only available
for the 9830 printer.

If you are using thermal direct supplies, do not load a ribbon.  If
you are using high energy supply, be sure to use a high energy
ribbon.  See "Using a High Energy Ribbon" for more information.
If you want to use a high energy ribbon, you must send the supply
setup packet every time the printer is turned on. 
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L o a d i n g  R i b b o n

Make sure the printer is configured to use a ribbon.

To load ribbon:

1. Open the cover.

2. Unlock the printhead by turning the retaining latch.
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3. Lift printhead assembly using the printhead tab until the
assembly locks into place. 

4. Push the deflector tab down.

Printhead Tab

Deflector Tab

Deflector Tab
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5. Slide the extra ribbon core on the take-up reel.  Use your
empty ribbon core as the take-up core.  The take-up core only
fits on the take-up reel one way.  (An extra take-up core is
available by ordering part number 117961.  See "Accessories"
in Appendix A for more information.)

6. Remove the new ribbon from the package as shown.  Do not
wrinkle or crush the new ribbon.

7. Slide the ribbon onto the back reel as far as it will go.  The
ribbon roll only fits on the reel one way.  Carefully unwind a
few inches of ribbon from the bottom of the roll.

Take-up Reel

Back Reel
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8. Carefully feed the ribbon under both ribbon rollers and
printhead as shown.

9. Tape the ribbon to the take-up core.  Do not tape the ribbon
to the take-up reel.

10. Align the ribbon and make sure it is straight and centered
throughout the path.

11. Rotate the take-up core until the MONARCH leader is past
the printhead.

Printhead

Ribbon Roller

Take-up Core

Take-up Reel
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12. Remove any slack in the ribbon by turning the take-up reel
clockwise.

13. Hold the printhead assembly by the printhead tab while
pressing down on the printhead release.

14. Close the printhead by pressing down on the thumb well until
you hear it click into place.  Close the cover.

Thumb Well
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U s i n g  a  H i g h  E n e r g y  R i b b o n

High energy ribbon is an option for the 9830 printer.  It enables
you to print on high energy (TUFF-MARK®) supplies.

When you select high energy ribbon for the printer setting, you
are setting the printer to a higher printing temperature.  Select
this setting only after you have loaded a high energy ribbon and
supply or it may damage your printhead.  To select a high energy
ribbon, send the supply setup packet everytime you turn on the
printer or use the Printer Configuration software (provided with
the printer).

The high energy setting is lost when you turn
off the printer.

H i g h  E n e r g y  R i b b o n  L i m i t a t i o n s

When using the high energy ribbon option:

u Use a print speed of 2.5IPS (inches per second).
u Printhead warranty is reduced to 100,000 inches.
u Serial bar codes cannot be printed.
u Do not use peel mode.
u No more than 20% of the supply should have print (black

coverage).

CAUTION
The high energy ribbon may break or stick to the

supply when more than 20% of the supply
contains print.

u Only white high energy supply should be used for bar code
printing.

u Reverse fonts cannot be used.
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u A non-printing area of at least .1 inch (2.54 mm) must exist on
the left and right edge of the ribbon.

u Do not print horizontal lines or bars.
u Graphics are limited.
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P R I N T I N G 5
This chapter explains how to 

u use on-demand mode printing.
u print an error label.
u print batch separators.
u adjust the print positions.
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P r i n t i n g

The host sends online packets containing print jobs to the printer.  

To print:

1. Turn on the printer.

2. Download a format and a batch.  (See Chapter 2, "Using the
Software," or the online version of the Packet Reference
Manual for information on downloading print jobs.)

The printer prints a strip of labels.

3. Remove the printed labels.

O n - D e m a n d  M o d e  P r i n t i n g

When the 9820 printer is operating in the on-demand mode, you
must press Feed to print a label.  The Paused light blinks when
the label is ready to print.

When the 9830 printer is operating in the on-demand mode, the
next label prints when the previous label is removed from the
printer or when Feed is pressed.  The Paused light blinks until all
the labels in the batch are printed.  You must use on-demand
printing with peel mode.  If you are using peel mode, remove the
excess backing paper by pulling up across the saw-toothed tear
edge.  Make sure the backing paper tears at the edge.

Hold the leading edge of peeled labels when
printing on stock longer than six inches.  The

minimum feed length for peel mode is 1.5
inches.  You must use non-perforated

supplies for peel mode.
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P r i n t i n g  a n  E r r o r  L a b e l

If the printer displays a data error (errors
0-499), press Feed to print an error label
and continue printing.  See your System
Administrator about the error label.

C l e a r i n g  B a t c h e s

All batches are cleared when the printer is turned on.  You can
also clear all or a single batch by pressing Clear after the printer
is paused.  See "Using the Control Panel" in Chapter 1 for more
information.

U s i n g  B a t c h  S e p a r a t o r s

A batch separator is a striped label that prints in between
batches.  For non-indexed (continuous) supply, the batch
separator is always six inches long.  The name of the batch is
shown on the batch separator.

To use batch separators, refer to the online version of the Packet
Reference Manual provided with your printer.
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A d j u s t i n g  P r i n t  P o s i t i o n s

You can adjust the supply, print, or margin positions on the printer
by using the control panel buttons.  Make sure a batch is not
waiting to print before you adjust the positions.

To change the supply, print, or margin positions:

1. Press Pause.

2. Press Feed and Clear (at the same time) once to select the
supply position, twice to select the print position, and three
times to select the margin position.  These buttons act as
toggle switches between the three (supply, print, and margin)
position adjustments.

When you select the position to change, the
current setting is displayed.

3. Press Feed to decrease the current position by one dot or
press Feed for two seconds to decrease the value by 10 dots.
OR
Press Clear to increase the current position by one dot or
press Clear for two seconds to increase the value by 10 dots.

If the position has a negative value, the
supplies light is on.

After you adjust the position (and release the
buttons), the setting is displayed.

4. Press Pause when you are done making adjustments.

Resend the format so these changes take effect.  You
cannot change the settings if the printer is paused while
printing a batch.  Change the settings after the batch is
done printing.

Review the following definitions for the different print position
adjustments.
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Supply Position Adjusts the machine to print at the vertical 0,0
point on the supply.  Increase the supply
position to move print up, decrease to move
print down on the label.  The range is -300 to
300 dots.

The supply position adjustment should only
be made on inital printer setup.  For format

adjustments, change the print position.

Print Position Adjusts where data prints vertically on the
supply.  Increase the print position to move
print up, decrease to move print down.  The
range is -99 to 99 dots.

Margin Position Adjusts where data prints horizontally on the
supply.  Increase the margin position to move
print to the right, decrease to move print to
the left.  The range is -99 to 99 dots.
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C A R E  A N D  M A I N T E N A N C E 6
This chapter tells you how to

u clear label jams
u clean the printhead and platen roller
u replace a printhead
u replace a fuse
u adjust print contrast.

CAUTION
Do not use sharp objects to clean the printhead.  This

may damage the printer and void your warranty.
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C l e a r i n g  L a b e l  J a m s

When you are printing and a jam occurs, the Supplies light on the
printer’s front panel blinks.  To clear the jam:

1. Turn off the printer.

2. Open the cover and printhead assembly.

3. If necessary, remove the label roll and ribbon.

4. Remove the jammed labels and reload the label roll.

5. Close the printhead assembly and turn on the printer.

6. Press Feed to position the supply under the printhead.

C l e a n i n g

The rate and frequency at which you print determines how often
you must clean the printer.

You may need to clean the printhead and platen roller:

u if there is any adhesive build-up in 
the supply path

u after printing approximately six rolls of
supply, after using two ribbons, or 
whenever you load new supplies

u daily if your printer is in an excessively 
dirty, hot, or humid environment

u when you see voids in the print as shown.

You may have to clean the supply sensor more often if you
frequently receive supply error codes.
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To clean the printhead, supply sensor, and platen roller:

1. Turn off the printer.

2. Open the cover and printhead assembly.

3. Remove the label roll and ribbon (when cleaning the
printhead).

4. Press down on the exit cover tabs to open the exit cover on
the front of the printer.

5. Moisten a cotton swab with isopropyl alcohol.  Turn the platen
roller with your finger and run the cotton swab across it.
Make sure the platen roller is clean all the way around.

6. Rub the cotton swab across the peel bar and remove any
build-up.  The peel bar is only available on the 9830 printer.

Exit Cover
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7. Moisten another cotton swab with isopropyl alcohol.  Rub the
cotton swab across the printhead and remove any build-up.

8. Rub the cotton swab across the supply sensor and remove
any build-up.

9. Clean the build-up in the supply path.

Supply Sensor
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10. Let the printer dry and reload your supplies.

11. Close the exit cover by pushing firmly on it as shown.  Both
latches will click into place.

12. Close the cover and printhead assembly.

13. Turn on the printer.

14. Press Feed to position the supply under the printhead.

Resend your format, batch, and
check digit packets.
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R e p l a c i n g  t h e  P r i n t h e a d

You may have to replace the printhead if it is damaged or
worn-out.  For example, you may see 616 (bad dot or dots) or 765
(printhead failure) error codes.  See Appendix A, "Specifications
and Accessories," for the printhead part number.

CAUTION
The printhead is sensitive to static electricity, which can
damage the printhead or reduce its life.  Ground yourself
by touching some metal, such as the printer’s metal base,

before touching the printhead.  Clean the printhead to
remove any salt or oil left from handling prior to operation.

To replace the printhead:

1. Turn off the printer.

2. Open the cover.

3. Unlock the printhead by turning the retaining latch.
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4. Press forward and down on the two latches on top of the
printhead assembly as shown.  The printhead will drop down.

5. Lift the printhead assembly using the printhead tab and push
back until the printhead assembly clicks into place.

6. Carefully unplug the cable from the printhead as shown.

CAUTION
The printhead is sensitive to static electricity, which can
damage the printhead or reduce its life.  Ground yourself
by touching some metal, such as the printer’s metal base,

before touching the printhead.

7. Carefully plug the cable into the new printhead.
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8. Align the new printhead with the tabs.

9. Snap the printhead into place.

Make sure the printhead cable does not
touch the ribbon roll.

10. Clean the new printhead with a cotton swab dipped in
isopropyl alcohol to remove any salt or oil left from handling.

11. Let the printhead dry and reload your supplies.

12. Close the printhead assembly and the cover.

13. Turn on the printer.

14. Press Feed to position the supply under the printhead.

Do not 
touch here
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A d j u s t i n g  t h e  W i d e / N a r r o w  K n o b s

You may need to adjust the two wide/narrow knobs according to
the width of your supply.  For supply that is more than two inches,
adjust the knobs to the wide setting.  For supply that is two inches
or less, adjust the knobs to the narrow setting.

You must adjust both of the knobs to 
the same position.

For wide supplies, push down and turn the wide/narrow knobs
clockwise with a screwdriver.

For narrow supplies, turn the wide/narrow knobs
counter-clockwise with a screwdriver until it pops back up.

The adjustment is shown in the wide position.
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A d j u s t i n g  t h e  P r i n t  C o n t r a s t

You may need to adjust the print contrast if the printing is too light
or too dark.  Having the correct print contrast is important
because it affects how well your bar codes scan and how long
your printhead lasts.

We recommend you check the bar code print
quality with a bar code verifier.

Using a thin screwdriver, turn contrast knob clockwise for darker
print; turn counter-clockwise for lighter print.

You only have to turn the contrast
adjuster slightly.

Your System Administrator can adjust the print contrast by
sending the print control packet.  See the online version of the
Packet Reference Manual for more information.  The Printer
Configuration software (provided with the printer) can also be
used to adjust the print contrast.

Contrast Knob
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R e p l a c i n g  t h e  F u s e

The printer is shipped with a 115 volt or a 230 volt fuse.

To replace the fuse:

1. Disconnect the printer from the power source.

2. Use a screwdriver to pry open the fuse box in the back of the
printer.

3. Remove the old fuse and insert a new one as shown.

4. Slide the fuse box back into the printer.

Fuse Box
Fuse
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T R O U B L E S H O O T I N G 7
This chapter provides

u information about printing a test label.
u solutions to minor printing problems.
u explanations of error messages you may receive while

using the printer.
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P r i n t i n g  a  Te s t  L a b e l

To print test labels:

Press Feed and Pause simultaneously.  Hold for one second
and release. Labels similar to these print:

The first label shows the printer’s configuration by packet (A-G).
See the online version of the Packet Reference Manual (included
on diskette) for more information.

The second label shows the model number, software version,
stock count, voltage, print contrast, printhead resistance, number
of bad dots, installed options, and DIP switch settings.  The test
label for the 9830 printer also shows an inch count for the high
energy ribbon.

If test labels do not print, press Feed and try again.  If that does
not solve the problem, call Technical Support.
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Tr o u b l e s h o o t i n g

This section helps you correct some problems that may occur.

Problem Action

Error message appears
during startup.

Turn off the printer, wait fifteen seconds and
then turn on the printer.  Call Technical
Support if the error message reappears.

Does not print. Check supply.
Check ribbon.
Send a corrected format and batch packet.

Does not feed. Set wide/narrow knobs correctly.
Partially printed data. Clean the printhead.

Send a corrected format packet.
Printing shadows or
smears.

Clean the printhead.
Change supply.
Check ribbon.

Light printing. Change supply.
Adjust the print contrast.
Check wide/narrow knobs.
Check ribbon.

Heavy printing. Clean the printhead.
Change supply.
Adjust the print contrast.
Check wide/narrow knobs.
Check ribbon.

Voids in printing. Clean the printhead.
Change supply type.
Check ribbon.

Serial bar codes do not
scan.

Use a print speed of 2.5 IPS.
Adjust the print contrast.

Backing paper is
wrapped around platen
or peel roller.

Carefully remove the backing paper.  Make
sure the backing paper tears at the
saw-toothed tear edge when using backfeed
and peel mode.

If you cannot fix a problem, call Technical Support.
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E r r o r  M e s s a g e s

You may receive the following types of error messages:

u Data Errors
u Communication Errors

Some errors numbered 400-438 and 500-574 are internal
software errors.  Errors numbered 900-999 are hard printer
failures.  If you cannot clear an error, turn off the printer, wait
several seconds and then turn on the printer.  Call Technical
Support if you receive any error message not listed in this chapter.

D a t a  E r r o r s

Errors 001 to 405 and 429 to 435 are data errors.  This type of
error indicates that incorrect data was sent to the printer, and the
printer is ignoring it.  Your System Administrator should correct
the packet and send it back to the printer.

Error Description/Action

001 Format ID number must be 1 to 999.

002 Name must be 1 to 8 characters inside quotes.

003 Action must be A (add) or C (clear).

004 Supply length is invalid.

005 Supply width is invalid.

006 Storage device must be R (volatile RAM).

007 Unit of measure must be E (English), M (Metric), or G
(Dots).

010 Field ID number is outside the range 0 to 999.

011 Field length exceeds 2710.
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012 Row field position is greater than the maximum stock
dimension.

013 Column field position is greater than the maximum stock
dimension.

014 Font selector is invalid.

015 Character rotation must be 0 (0 degree), 1 (90 degree),
2 (180 degree), or 3 (270 degree).

016 Field rotation must be 0 (0 degree), 1 (90 degree), 2
(180 degree), or 3 (270 degree).

017 Field restriction must be V (variable) or F (fixed).

018 Code page selection defined in the field must be 0
(Internal), 1 (ANSI), 2 (DOS 437), or 3 (DOS 850).

020 Vertical magnification must be 1 to 7.

021 Horizontal magnification must be 1 to 7.

022 Color must be B, D, O, R, or W.

023 Intercharacter gap must be 0 to 99 dots.

024 Field justification must be B (balanced), C (centered), E
(end), L (left), or R (right).

025 Data length is too long.

030 Bar code height must be at least 20 (English), 51
(Metric), 40 (Dots), or is not within the supply
dimensions.

031 Human readable option must be 0, 1, 5, 6, 7, or 8.

032 Bar code type is invalid.

033 Bar code density is invalid.

040 Line thickness must be 0 to 99 dots.

Troubleshooting    7-5



041 Line direction must be 0, 90, 180, or 270.

042 The line segment or box end row is defined outside of
printable area.

043 The line segment or box end column is defined outside
of printable area.

044 Dot pattern for line or box must be "".

045 Line length is defined beyond the maximum length.

046 Line type must be S (segment) or V (vector).

051 Imaging mode in the graphic header must be 0.

101 Format referenced by batch not in memory.

102 Print quantity is outside the range 0 to 32000.

104 Batch mode must be N (new) or U (update).

105 Batch separator must be 0 (Off) or 1 (On) in the batch
control field.

106 Print multiple is outside the range 1 to 999.

107 Cut multiple is outside the range 0 to 999.

108 Multiple part supply is outside the range 1 to 5.

109 Reserved for knife usage.

200 Option number must be 1, 4, 30, 31, 42, 50, 60, or 61.

201 Copy length is outside the range 0 to 2710.

202 Copy start position must be 1 to 2710.

203 Destination start position must be 1 to 2710.

204 Source field must be 0 to 999.
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205 Copy type must be 1 (Copy after rules) or 2 (Copy
before rules).

206 Increment/Decrement selection must be I (increment) or
D (decrement).

207 Incrementing start position must be 0 to 2710.

208 Incrementing end position must be 0 to 2710.

209 The incrementing amount must be 0 to 999.

210 Security value for a PDF417 bar code must be 0 to 8.

211 Narrow element value is less than 1 or greater than 99.

212 Wide element value is less than 1 or greater than 99.

213 Dimension must be 1 to 30 for a column or 3 to 90 for a
row.

214 Truncation code must be S (standard) or T (truncated
bar code).

215 Aspect code must be C (columns) or R (rows).

216 Option definition must be S (set) or T (template).

217 Input device must be D (Default), H (Host), K
(Keyboard), N (None), or S (Scanner).

218 Pad direction must be L (from left) or R (from right).

219 Pad character is outside the range 0 to 255.

220 Check digit selection must be G to generate check digit.

221 Primary or secondary price format is outside the range
1 to 15.

222 Data type restriction is outside the range of 1 to 6.

223 Option is not valid for the field.
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224 Bar code Intercharacter gap must be 0 to 99 in printer
dots.

251 Power up mode must be 0 (online) or 1 (offline).

252 Language selection must be 0 (English).

253 Batch separator code must be 0 (off) or 1 (on) in the
system setup packet.

254 Slash zero selection must be 0 (standard zero) or 1
(slash zero).

255 Supply type must be 0 (black mark) or 1 (die cut).

256 Ribbon selection must be 0 (direct) or 1 (transfer).

257 Feed mode must be 0 (continuous) or 1 (on-demand).

258 Supply position is outside the range.

259 Contrast adjustment must be -390 to 156 dots.

260 Print adjustment must be -99 to 99 dots.

261 Margin adjustment must be -99 to 99 dots.

262 Speed adjustment is invalid.

263 Primary monetary symbol is invalid.

264 Secondary symbol selection must be 0 (none) or 1
(print secondary sign).

265 Monetary decimal places must be 0 to 3.

266 Character string length in Packet E must be 5 (MPCL
control characters) or 7 (ENQ/IMD command character).

267 Baud rate selection must be 0 (1200), 1 (2400), 2
(4800), 3 (9600), 4 (19.2), or 5 (38.4).

268 Word length selection must be 0 (7 bits) or 1 (8 bits).
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269 Stop bits selection must be 0 (1 bit) or 1 (2 bits).

270 Parity selection must be 0 (none), 1 (odd), or 2 (even).

271 Flow control selection must be 0 (none), 1 (DTR/DSR),
2 (CTS/RTS), or 3 (XON/XOFF).

272 Internal code page selection must be 0 (Internal), 1
(ANSI), 2 (DOS 437), or 3 (DOS 850).

273 Cut adjustment must be -300 to 300 dots.

282 RS232 Trailer string is too long.  Use a maximum of 3
characters.

283 ENQ Trailer string is too long.  Use a maximum of 3
characters.

284 The buffer type must be T (transmit), R (receive), I
(image), F (format, batch data, and graphics), D
(downloadable fonts), or V (vector/scalable fonts).

285 The storage device type must be N (non-volatile RAM)
or R (volatile RAM).

286 The buffer size is invalid.

287 The printhead width is invalid.

290 Action must be 0 (disable) or 1 (enable) for Backfeed
Control.

291 Dispense position must be 50 to 200 dots and/or the
backfeed distance is greater than the dispense position.

292 Backfeed distance must be 10 to 200 dots.

310 Check digit scheme number must be 1 to 10.

311 Modulus must be 2 to 11.

314 Check digit algorithm must be D (sum of digits) or P
(sum of products).
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325 Duplicating direction must be 0 or 1.

327 Amount of row adjustment must be 0 to 999.

328 Duplicate count must be 0 to 999.

340 Bitmap line encoding must be H (Hex) or R (Run length).

350 Font selector must be 1 to 9999.

351 Font data length must be 68 to 16384.

352 Insufficient font memory is available for the downloaded
font.

380 Job request is outside the range 0 to 4.

400 Invalid character following {.

401 Internal software failure.  Call Technical Support.

402 Field separator is not in the expected location.

403 Field separator was not found.

404 The number or string that is currently being processed
is too long.

405 Too many fields exist in the format.

C o m m u n i c a t i o n  F a i l u r e s

Errors 409 to 413 usually indicate a communication failure.
These errors happen when the host and the printer cannot
communicate.  Ask your System Administrator for help.

Error Description/Action

409 Printer memory is full.

410 Parity mismatch.

411 Framing error (baud rate mismatch).
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412 Flow control mismatch.

413 Receive buffer is full.  Check flow control settings. 

414 Internal keyboard buffer is full or you need a new
keypad.

427 Format name must be 1 to 8 characters inside quotes or
a printer-assigned name ("").

428 Batch name is invalid or graphic not found.

429 A field number appears more than once in a format.

430 The format uses a graphic file that cannot be found.

433 The batch references a field number that does not exist
in the format.

497 Error occurred during the parallel port loop back test.

499 Error occurred during the serial port loop back test.

D a t a  F o r m a t t i n g  E r r o r s

Errors 571 to 618 are data formatting errors.  This type of error
happens when a field prints incorrectly.  Your System
Administrator can correct the format, batch, or graphic packet and
send the print job again.  For errors 571 to 614, the printer will
still print, but the data may be incomplete, missing, or wrong.

Error Description/Action

571 UPC or EAN bar code data length in the batch doesn’t
fit the format.

572 Batch data doesn’t fit the format, the field contains
blanks, or data mismatch.

573 Batch data in price field doesn’t fit the format or the
field contains blanks.
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574 Batch data in check digit scheme doesn’t fit the format,
or, the field contains blanks.

575 The graphic included in your format could not be found.

600 Imaging error because the batch was refused.

601 An error occurred while the batch was imaging.

602 The batch was not found during imaging.

611 Font, bar code, or density in the batch doesn’t fit the
format.

612 Batch data is missing or doesn’t match the format.

613 Reference point off tag.

614 Portion of field off tag.

615 Bar code width is greater than 16 inches, or keywords
on PDF 417 bar code exceed 928.

616 A bad dot falls on a bar code and the dot cannot be
shifted.  Call Customer Service to order a new
printhead or printhead kit.

618 Magnification must be 1 to 7.

M a c h i n e  F a u l t s

Errors 700 to 765 happen when there is a problem with the printer.

Error Description/Action

700 An error is pending, and the printer cannot continue
with the batch.

701 Printer received a command that it cannot execute
while it is running.

702 Check your printer’s SETUP settings.
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703 The printer sensed a calibration of different-sized black
marks.

704 Printer didn’t detect a sense mark within the maximum
feed length or is out of supplies.  Check or load
supplies.

705 Invalid batch received.

750 Printhead is overheated.  Turn off the printer and let it
cool.

751 Printer didn’t detect a sense mark when expected.

752 Printer detected a sense mark in the wrong place.

753 Printer detected a sense mark that is too long.

754 Out of ribbon or ribbon jam.  Check or load ribbon.
Remove any slack in the ribbon by turning the take-up
reel clockwise.

755 Printhead is open.  Close the printhead.

756 Out of supplies.  Load supplies.

757 Reload supplies (supply length mismatch).

758 The supply was not seen or the on-demand sensor is
not working correctly.  Check for a supply jam.  Clear
the supply path or reload supplies.  This error may
occur if you remove a label too quickly in the
on-demand mode.  The printer does not recalibrate
after this error.

759 Knife is not moving.  Call Technical Support.

760 Knife jam.  Remove any jammed tags from the knife.
Call Technical Support.
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761 Stacker is full or jammed.  Empty the stacker or clear
the jam before continuing.  The printer does not
recalibrate after this error.

762 Low battery.  Recharge the battery.

763 Waiting to dispense label.  Press Feed.

764 Verifier failure.  Press Clear to clear the error and
continue printing.  A blank label feeds and the last label
reprints.

765 Printhead failure. Call Customer Service to order a new
printhead or printhead kit.

768 Printhead has more than 10 bad dots or is not
connected.  Make sure the printhead is connected.  If
necessary, call Customer Service to order a new
printhead or printhead kit.

770 The print motor is not ready.  Call Technical Support.

771 The format specified by the application was not found.
Reload your application and format and try again.

790 The printer is busy.  Wait until the printer is idle (not
receiving data or no batch waiting to print) before you
send any packets.  This error may occur when you try
to print a test label if the printer is busy.

791 The printer has an error pending.  Turn off the printer.
Wait 15 seconds and turn it back on.  Resend the
packets.

792 The printer is not initialized.  Call Technical Support.

793 The printer job queue is full.  Turn off the printer.  Wait
15 seconds and turn it back on.  Resend the packets.

Errors numbered 900-999 are hard printer failures.  Call Service if
you receive these messages.
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S P E C I F I C AT I O N S  &
A C C E S S O R I E S

A

P r i n t e r

Height: 12.5 inches (318 mm)

Width: 12 inches (305 mm)

Depth: 13 inches (330 mm)

Weight: 25 lb. (11 kg) for 9820 printer
29 lb. (13 kg) for 9830 printer

Shipping Weight: 29 lb. (13 kg) for 9820 printer
33 lb. (15 kg) for 9830 printer

Power: 115 Vac, 60Hz, 100 Vac, 50/60 Hz, 230 Vac, 50Hz

Operating Limits: For Thermal Transfer (ribbon) 40° to 95° F 
(4° to 35° C)

For Thermal Direct 40° to 104° F 
(4° to 40° C)

Printhead: Thermal at 4 inches (102 mm) wide
203 dpi (8.0 dots per mm)

Printing Method: Thermal Transfer (ribbon) or Thermal Direct

Supply Types: Thermal Transfer or Direct

Supply Widths: 1.2 inches (31 mm) minimum
4.25 inches (108 mm) maximum

Supply Lengths: 1 inch (25 mm) minimum
12.0 inches (305 mm) maximum for 9820 printer
16.0 inches (406 mm) maximum for 9830 printer
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R i b b o n  S p e c i f i c a t i o n

Ribbon Storage: Do not leave ribbon in direct sunlight, high
temperatures, or high humidity.
For high temperature or high humidity
environments, contact Monarch for supply
recommendations.

Print Speed: u 2.5 IPS (64 mm) for all serial bar codes
u 2.5 IPS (64 mm), 4.0 IPS (102 mm), or 6.0

IPS (152 mm) for other operations.

We recommend a print speed of 2.5 IPS for labels less than two
inches long using backfeed or on-demand mode printing.

Ribbon Type: Standard or High Energy (only available on
9830 printer)

Ribbon Widths: 1.3 inches (33 mm)
1.6 inches (41 mm)
2.16 inches (55 mm)
3.15 inches (80 mm)
4.13 inches (105 mm)

Ribbon Length: 23,600 inches (600 meters)

A c c e s s o r i e s

u International Fonts
u Internal TwinAx/CoAx Protocol Converter  Part # 117532
u LAN Print Server RJ-45 Connector (10BaseT)  Part # 11753101

BNC Connector (10Base2)  Part # 11753102
u Printhead Assembly Kit Part # 117971
u Ribbon Take-up Core Part # 117961-20, -30, or -40 (available

in two, three, or four inches)
u High Energy Ribbon (9830 printer only)
u Tear Bar
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S E T T I N G  D I P  S W I T C H E S B
To change the DIP switch settings, move the switches to the
desired position and then turn on the printer.

If you select Software Controlled, the parameters in Packet F will
override the communication settings.  Software Controlled uses
the last sent Packet F settings or the defaults.  Turning on the
printer activates the DIP switch settings.  Make sure the DIP
switch settings match the printer’s setup for ribbon or supply type.

Upper Dip
Switches

Lower Dip
Switches
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D I P  S w i t c h e s

Upper DIP Switches

1 2 3 4 5 6 7 8
Baud Rate
38400
19200
9600
4800
2400
1200
Software Control

ON
ON
ON
OFF
OFF
OFF
OFF

ON
OFF
OFF
ON
ON
OFF
OFF

OFF
ON
OFF
ON
OFF
ON
OFF

Data Bits
7 Data Bits
8 Data Bits

ON
OFF

Stop Bits
2 Stop Bits
1 Stop Bit

ON
OFF

Parity
Even
Odd
None

ON
OFF
OFF

OFF
ON
OFF

Parallel Port
Centronics Mode
IEEE-1284

OFF
ON
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Lower DIP Switches

1 2 3 4 5 6 7 8
Flow Control
XON/XOFF
RTS/CTS*
DTR

ON
OFF
OFF

OFF
ON
OFF

Diagnostics
Normal
Diagnostics Mode

OFF
ON

Verifier
No Verifier
Verifier Installed

OFF
ON

Supply Type
Continuous
Die Cut
Black Mark

ON
OFF
OFF

OFF
OFF
ON

Ribbon
Transfer
Direct

OFF
ON

Feed Mode
Disable On-Demand
Enable On-Demand

OFF
ON

* Requires a special cable.
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G L O S S A R Y

The following terms will help you use this manual.

continuous mode Mode in which the printer prints all the labels in the
batch without stopping.

download (send) Transmission of data from the host to your printer.

format Supply layout or design, which the System
Administrator downloads as a format packet to your
printer.

host Any mainframe, minicomputer, data collect terminal, or
personal computer sending data to the printer.

LCD Display on the printer used to indicate printer conditions
and problems.

MONARCH leader Wrap around a new roll of ribbon with Monarch printed
on it.

on-demand mode Mode in which the printer stops after each label to allow
you to remove it.

print job Actual data printed on a label or tag.  The host may
download the print job together with the format, or as a
separate packet.  The print job is also called a "batch."

online Direct communication between a computer and the
printer.

Supply Sensor Senses whether supply is loaded or needs to be loaded
in the printer.  Located in the supply path.

Supplies Labels used for printing.

System 
Administrator

Person responsible for creating and downloading
packets.
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